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Writing Tips for Microsoft Word

These writing tips are based on Microsoft Word 2000.  If you have a different version, the toolbars and menus may be slightly different.

General Microsoft Word Overview

This is Microsoft Word’s Main Toolbar:
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Clicking on any of these words will take you to the corresponding menu.  For instance, this is what you see when you click on the word “Window.”
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This menu allows you to manage your documents within Microsoft Word by clicking on one of the choices on the menu.  Following is a description of each of your options.

	Menu Option
	Description

	New Window
	If you click “New Window,” you will have the same document open in two windows.  This is sometimes helpful when you are doing a lot of revisions and your document is extremely long.

	Arrange All
	You might want to compare your current document to an old draft.  You could do this by opening both and then selecting “Arrange All.”  One document will be on the top, and the other on the bottom.

	Split
	You might want to keep your References page open and compare the entries to your citations.  You could do this by selecting “Split” and then clicking on your screen where you want the division to go.  Then you would scroll to the References page in one part of your screen, and scroll through your citations in the other part.  Unlike New Window, this doesn’t create two separate documents that you could save separately.  Every change you make in one section will automatically update in the other.


This menu also lists all the documents that you are currently working on.  If there is more than one, you can click on the name of a document to switch to it.

Each of the other menus has similar scintillating options.  You can learn a lot about Microsoft Word by trying the different menu options.  Just be sure to save your important documents before trying anything new. (
The File Menu
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	Menu Option
	Description

	New
	This option allows you to start a new document based on the template of your choice.  There are also several wizards accessible through this option that allow you to create complicated things such as mailing labels, manuals, or even a thesis using step-by-step processes.  There are also templates for things such as memos, letters, and faxes should you be so inclined. (

	Open
	This fun option allows you to open a document previously created.  This option is useful if someone on your team creates a document and passes the file on to you.

	Close
	This will close the current document, but leave you within the Microsoft Word program.  If you have any other documents open, they will remain open.

	Save
	This will save the current document with its current name, and with the current settings.

	Save As
	This will save the document, but give you a chance to change the name and type of document.  For instance, if the Writing Lab returns your paper and asks you to save it in .doc format, this is where you would do that.  You would change the type to Word Document, and click Save, and the document should then be accessible to the Writing Lab.

	Save as Web Page
	This allows you to save your current document as a Web page.  Actually getting it onto the Internet is a little bit more complicated, but should you ever have the need, this option will get your document Web-ready.  Be aware though, that some of your formatting could be lost, just because Web pages don’t support everything that Word supports.

	Versions
	This feature allows you to save different versions of your document, open or delete old versions, and view the comments associated with each one.  This is helpful sometimes if you have a lot of people working on one document, or you make changes that you aren’t sure about… you can save a version before the changes, and then there will always be the option of going back to that version if the changes don’t work out.

	Web Page Preview
	This allows you to see what your document would look like as a Web page.  This is helpful if you are planning to make it a Web page someday.  If you aren’t, then it really isn’t very useful, although I suppose you could look at it for entertainment value if you are desperate.

	Page Setup
	This is a very nifty option that allows you to change your margins or turn your page sideways if you like it better that way (landscape orientation rather than portrait)… although for school papers I wouldn’t recommend it, some of the instructors are kind of traditionalists that way. (  It also allows other mysterious and complicated things such as odd and even headers and footers, page borders, or vertical centering.  In order to integrate any of these into a regular document you need to know about section breaks, but feel free to experiment (after you save your important documents).  Some of the features are quite cool.

	Print Preview
	This option allows you to see the future.  As closely as Word is able to predict, it shows you what your paper will look like when it is printed.  Its only limitation is that it has a very hard time predicting if you have no printer hooked up to your computer, so don’t expect a lot if that is the case.  Even the greatest oracles have their limitations. (

	Print
	This allows you to print your paper, but unlike the button on the toolbar, choosing this option allows you to change settings before you do so, such as how many pages you want printed on each piece of paper, how many copies you want printed, or whether you only want to print the current page.

	Send To
	This opens up another mini-menu that allows you to send your document by e-mail or fax to someone else.  It also allows you to route documents for approval.  The options that you have on your computer will limit the functionality of some of the options.  For instance, if you have no fax machine or fax program, then you still won’t be able to fax a document using Word alone.

	Properties
	This allows you to look at the current document properties, such as when the document was created and the last time it was saved.  You can also look at the title and author of the current document.  The statistics tab allows you to see the word count and the total time that you have worked on the document.

	Exit
	This will close the Microsoft Word program and all documents that you have open.


In addition to these menu choices, there is also a list of the most recent documents that you have worked on.  Clicking on the names of any of these will open the document indicated, if it is still available in the same location.

The Edit Menu
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	Menu Option
	Description

	Undo [whatever the last command was]
	This option allows you to repent of whatever you just did, and erase the consequences.  An amazing option really, too bad we don’t have an Undo option in our regular lives. (  For instance, if you just had Word search the entire paper for spaces and remove them all, using this command will save you from a paper composed of only one really reeeeeeeally long word… and believe me, you want to be saved from that.

	Repeat [whatever the last command was]
	This is a helpful option if you have to do something really repetitive.  For instance, if you just typed your name, and you like the way it looks, and you want to see it again, you could repeat it over and over again until it filled the page.  The shortcut is CTRL + Y for this, and it is fun to play with if you have to say something over and over and over and over and over and over and over and over and over and over and over and over and over again and you are bored with typing it. (  Entering symbols (using Insert | Symbol) will always repeat just the symbol, but the amount of typing it captures depends on how fast you type and what you do in between.

	Cut
	This option will cut the highlighted information out of your text and put it on the clipboard. The shortcut is CTRL + X.

	Copy
	This option will copy the highlighted information to the clipboard, but leave it in its current position as well.  The shortcut is CTRL + C.

	Paste
	This option will paste whatever was last copied to the clipboard and paste it into your paper at the point of the cursor.  The shortcut is CTRL + V.

	Paste Special
	This option allows you to paste whatever is on the clipboard to your paper, but in a different format.  For instance, if you copy a lot of text out of a table, but you don’t want it to be in a table when you paste it, then you would paste special and select “unformatted text” so that it comes in as a paragraph and not as a table.

	Paste as Hyperlink
	This option allows you to copy text from a certain place, and then add a link to that place somewhere else by pasting as a hyperlink.  For instance, if you are in chapter two of your book, but you are describing Figure 4 from chapter one, and you want your reader to be able to go back and look at it, you go back to chapter one and copy the words “Figure 4” from where you have them already, and then you paste it as a hyperlink into chapter two.  Sounds complicated, but it isn’t, really.  And then the people can read along and click on the words “Figure 4” to go right there.  Of course, this only works if you have people reading your document in an electronic form.  Printing it out kind of destroys the efficacy of the hyperlinks. (

	Clear
	Choosing this option will delete whatever character is to the right of your cursor.  Using the DEL or DELETE key on your keyboard will do the same thing.

	Select All
	This will select everything within your document.  This is helpful sometimes if your document becomes corrupted for some reason and you want to cut and paste the entire thing into a new document.  It doesn’t always work, but it is worth a try.  Also, it is helpful if you want to remove ALL the highlighting or update ALL the fields in your document.

	Find
	This is a cunning little feature that will search through your whole document and find whatever you type into the Find what field.  This is helpful if you want to make sure you used all of the entries in your References (APA) or Works Cited (MLA) list in your paper, or you have to count how many times you used them.  You can start by typing the first author’s name into the Find what field, click Find Next, and it will take you to the first instance of the name in your paper.  Clicking Find next again will find another instance, etc.

	Replace
	This is an extremely useful feature that will replace whatever you type in the Find what field with whatever you type in the Replace with field.  This is great if you are writing a story about Bob Reynolds, and decide that you would rather have his name be Matt Reynolds.  You can type “Bob” into the Find what field, and “Matt” into the Replace with field, and click Replace All.  You have to be careful with the Replace All button though… if you happened to use the word “bobsled” in your paper, it will now be “mattsled.”  If there is any chance of something like that happening, you might want to just click Find Next, and decide every time. (

	Go To
	This feature allows you to go somewhere in your document quickly.  You can tell it to go to page 349 and it will take you there (if there are that many pages, of course).  You could also tell it to go to a certain heading, or a bookmark (if you know how to use styles or make bookmarks).

	Links
	This option will only be accessible if you have linked objects in your document.  If you do, then this selection will allow you to edit the links. (  If you don’t, don’t pine away wondering what it could be.  It really isn’t all that cool.

	Object
	This option changes depending on what you have selected.  If you have a picture selected, for instance, it will change to “Edit Picture” and become active, so that you can use it to edit the picture.  Actually, right clicking on most objects will get you a wider variety of selections than this will ever give you, so if I were you, I might just ignore this option altogether.


The View Menu
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	Menu Option
	Description

	Normal
	These options are all about perspective.  Your paper remains the same paper, but the way you perceive it is completely different.  These options might even lead you to a higher state of being… though I wouldn’t count on it. (  Normal allows you to see your paper in the normal (for Word at least) way, with no space between pages, no discernible margins, etc.  The Web layout allows you to see your paper as though you were viewing it on the Internet (good for a laugh or two at least).  The Print layout is my personal favorite, so I may be biased here, but I like it because it allows you to see your margins and the breaks between pages, so that you get the whole effect and you can see what kind of a visual impact you will have on your reader. (  Of course, I’m into things like that….  The Outline view is just that, your paper as an outline.  This is good if what you are writing is an actual outline.  If not though, it isn’t that exciting.

	Web Layout
	

	Print Layout
	

	Outline
	

	Toolbars
	This selection brings up another mini-menu that allows you to choose to view, or un-view (no, that really isn’t a word, but you know what I mean…), several exciting toolbars. (  There is even a “Customize” option where you can make your own toolbar, or add new buttons to the ones you already have.  If you would like to know how to do this, see the specific question “How do I add a button to my toolbar?” on page 19.

	Ruler
	Ah, an extremely useful bar that you turn on and off by selecting it here.  The Ruler bar allows you to change indentation and set tabs and text boundaries without having to go to the Format menu.  If you want to experiment, try clicking on the bar, then double click on the little tab you created.  When you are done with that window, try clicking and dragging the text boundaries (the little triangles) around and see what happens.  Quite entertaining… and useful, once you get the hang of it. (

	Document Map
	Selecting this option will give you a remarkably interesting little document map on the left side of your screen (you can change the size of this window by clicking and dragging the dividing bar).  Again, to make the most use of this feature, you need to know about styles (normal, heading 1, heading 2, etc.).  If you have heading styles in your document, they will show up here in outline form, and clicking on any one of the items will take you directly there. (  (Also, clicking on the little plus and minus signs will expand and contract each topic and subtopic.)

	Header and Footer
	Viewing the Header and Footer allows you to put in a header or a footer. (  This is especially useful when you are writing papers in MLA or APA format, since each of these requires a header.  Also, when you view the Header and Footer, the Header and Footer toolbar pops up, which also has some very useful buttons you can use to add a page number to your header, format the page number that is already there, and much more! (Do I sound like a commercial yet?)

	Footnotes
	If there are footnotes in your document, this option allows you to view them.

	Comments
	If there are comments in your document, this option allows you to view them. (

	Full Screen
	Selecting this option allows you to see your document using the full screen of your computer.  All of the annoying extra toolbars will be gone, and you will be able to see your page in all its glory.  To do anything else, you’ll have to close out of full screen view, but it is kind of fun. (

	Zoom
	Zoom is great.  It allows you to view your document at page width or margin width, or zoom in to 500%.  This helps if you prefer large-print books, or if you need to see something a little bit better in order to draw a picture or correct your grammar. (  The only problem with making your document so large is that you have to do a lot of scrolling in order to see it.  The many pages option is cool as well.  It allows you to look at two or more pages of your paper at once.  This is useful if you want to see what they look like from afar, or if you are comfortable with really really small writing. (


The Insert Menu
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	Menu Option
	Description

	Break
	This versatile option allows you to put in all kinds of breaks.  Page breaks, column breaks, section breaks, and text wrapping breaks.  For all your breaking needs. (

	Page Numbers
	This option allows you to put automatic page numbers in your document.  However, for MLA and APA papers, you should instead use the Insert Page Number button on the Header and Footer toolbar to insert your page number (one space after your last name for MLA papers and five spaces after your abbreviated title for APA papers).  (The Header and Footer toolbar opens when you select View | Header and Footer from the main toolbar.)

	Date and Time
	This allows you to put the date, time, or a combination of both in your document, in a myriad of formats.  It also allows you the option of having the date update automatically.  This feature is useful when you want to know what day you printed something, as the electronic date will always update to today.  However, it is not so great if you want to remember when you wrote something.

	AutoText
	Selecting this takes you to another mini-menu where you can insert several previously stored phrases, appropriate for letters or other formal correspondence.

	Field
	This allows you to put a field into your document.  You could total a column of figures, or get the document to display the name of the author at a certain point.  This option is pretty advanced, although you are welcome to try it out.  As always, make sure you save any important documents before experimenting.

	Symbol
	This allows you to insert em dashes (—), accented characters (ë, î, ã, ė), copyright symbols (©), and a lot more very interesting items.  I like this option because it allows you to write résumé rather than resume. (

	Comment
	This allows you to enter a comment into a paper at the point of your cursor.  This is very useful when you want to make comments in someone’s paper without changing anything.  You just have to make sure that both you and the other person know how to create and delete comments. (

	Footnote
	This allows you to put a footnote in your document where your cursor is.

	Caption
	This allows you to add a caption to the picture or object you currently have selected.

	Cross-reference
	The cross-reference option allows you to put a reference to another part of your document at the point of your cursor.  You can cross reference the reader to a heading or a figure (if you use heading and figure styles), or you can create a bookmark anywhere and reference the reader to it.

	Index and Tables
	This allows you to add an index or a Table of Contents to your document.  These area lso based on styles.  The Table of Contents is generated from Heading styles, for instance.

	Picture
	This allows you to insert a picture into your document.  When you choose it, you will get further choices, and you can insert the picture from a file already on your computer, you can find some clip art, or you can insert something else, such as a scanned document or a chart.

	Text Box
	This puts a text box into your document.  Text boxes are good for setting aside certain information, and they are versatile, as they can be shaded and have various borders or none at all.

	File
	This option allows you to add a file to your document.  For instance, if you constructed your title page in a separate document, and now want to add it to your paper, you would place your cursor at the beginning of your document and select this option.  (Then, of course, I would check your header to make sure it didn’t change.)

	Object
	This allows you to insert other objects into your document, such as large pictures or flowcharts constructed in other programs.  This, for instance, is the best way to get a Visio flowchart into your document.  If you save it as another type of file and insert it using Insert | Picture, it won’t look the same, and you will be unable to revise it.

	Bookmark
	You can insert a bookmark in conjunction with cross-references.  First you highlight the text or object that you want to refer to, then you select this option.  You have to name the bookmark and click Add to add one, and then in the Cross-reference options there will be a bookmark for you to work with.

	Hyperlink
	This is a nifty option that allows you to add a hyperlink to your document.  You can either highlight a word already in your document that you want to make into a hyperlink, or you can just select the option and type in the word there.  You can hyperlink to any Web page, or you can type in an e-mail address to link to.  Here is an example: University of Phoenix.


The Format Menu
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	Menu Option
	Description

	Font
	This allows you to change a lot of things about your font, such as the size, color, style, and whether they have different effects, such as being crossed out (strikethrough) or if you want small capital letters (small caps).  If your document is going to be viewed electronically, there are other things that you can do on the Text Effects tab that are more showy.  Even though they are usually not appropriate for normal papers, they are fun to experiment with.

	Paragraph
	This is a frequently used option which helps you to change line spacing and indentation if you don’t have buttons on your toolbar to do so, or are unfamiliar with the ruler bar.  This option can also do some things that you can do nowhere else in the program, such as add space to the beginning or end of each paragraph.  Again, this is usually not appropriate for regular papers, but can be invaluable in a professional letter, newsletter, or a technical document.

	Bullets and Numbering
	This option allows you to choose a bullet or numbering style and customize it, if necessary.

	Borders and Shading
	This allows you to shade, or add borders to, a word or paragraph in your document.  If you choose to use this option, make sure you pay attention to the “Apply to” field that is on each tab, so that you don’t unintentionally shade your entire document chartreuse or something. (

	Columns
	Columns are great if you are trying to fit a list into your document and want it to go horizontally rather than vertically.  Highlight the list, and then select Format | Columns and experiment to see how many are appropriate, and how you would like them spaced.  They are good for other things too.  Make sure you pair this option with the Insert | Break option, so that you can put column breaks in and put your text where you really want it. (

	Tabs
	This option allows you to set the tab positions, and change different options.  If you are putting in a table and are unable to use the automatic tables, this can help you set up a right tab at the right margin with a dot leader, so that your table looks perfect. (

	Drop Cap
	This allows you to do something that you usually see in books of Fairy Tales. (  Drop the first letter of a word down several lines so that it is bigger and way more prominent than all the rest.  It can’t be done in a table, so below this table there is an example.

	Text Direction
	This is a great option if you want to put a label on a graph or have any other sensible reason for wanting your letters to go from bottom to top rather than left to right. (

	Change Case
	This is a fantastic option if you are one of those scary people who enjoys writing with CAPITAL LETTERS ALL THE TIME.  When some nice person from the writing lab asks you to tone it down, you can highlight all of your capitals and change them to Sentence Case.  Of course, you can use it to put titles in Title Case, or if you really need to use capitals, such as within an acronym, then you can select the UPPERCASE option. 

	Background
	This is something you want to be careful with. (  You can waste a LOT of printer ink trying to print your entire paper with a nice yellow background.  Experiment with it, just be sure to remember where your Undo button is. (

	Theme
	This is a great option for PowerPoint aficionados.  Instead of having your paper look like a paper, you can make it look like a presentation. (  Complete with background and cool bullets.  If you have a data projector, you can dazzle your classmates.  Of course, again, if you have to print it and turn it in, it might use up a lot of ink. (

	Frames
	This option is for use when you are making Web pages with your document.  It allows you to add a separate frame area that users can scroll through apart from the main page.

	AutoFormat
	This is a somewhat scary option because Word goes through and formats your document for you.  If you don’t want it to apply its own styles, or change certain things, then you need to turn those options off before you allow it to touch your stuff. (  Of course, if you DO want that, then go for it. (  You can always revert to your saved version if it looks worse instead of better. (

	Style
	This is where you can create or modify styles.  This is interesting and useful if you write a lot of things and want them customized.  You can modify Word’s built-in styles as well, at least to a certain extent.  There are different kinds of styles, paragraph styles and character styles.  The paragraph styles will change the entire paragraph to that formatting.  Character styles will only change the text (characters) that you have selected.

	Object
	This option will be active if you have an object, frame, or picture selected, and will allow you to change the borders and the text wrapping for that object.


Drop Cap Example:

O

nce upon a time there was a snowcone.  It was a very delicious-looking snowcone, made with nicely-shaved ice and covered perfectly with lime syrup.  It was the prize possession of the Princess, who kept it in a display freezer beside her throne for all to see.  One day, some travelling adventurers came to see the snowcone, and knew they had to have it for themselves, so they began to plan . . . 

The Tools Menu
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	Menu Option
	Description

	Spelling and Grammar
	The Writing Lab is wholly in favor with this option.  Using the spelling and grammar check will help you to correct spelling and grammatical errors in your document.  You have to be careful though, and not just let it correct things on its own.  The Spell Check doesn’t know all the words that you do, and the Grammar Check finds errors that really aren’t there from time to time, so you have to keep a close watch. (

	Language
	This option allows you to set a different language if you happen to be multi-lingual, and to use the Thesaurus.  You can also hyphenate your document… but don’t, unless you are in the publishing business and you must.  The thesaurus is my personal favorite, when I have to find other options for the word “cool” for instance. (

	Word Count
	This option will count the words in your document.  But no, it doesn’t stop there.  It also counts your pages, your characters, your paragraphs, and your lines.  This is good when your instructor assigns a word count for a document, or if you submit your writing to magazines or contests where they have character count or line maximums.

	AutoSummarize
	This is a really fascinating option because you can see what Word thinks are the most important things in your document.  If you use it, be sure to review the summary and make sure that it actually highlights important parts of your paper.

	AutoCorrect
	This option allows you to correct things in your document such as changing “(c)” to “©” or “hte” to “the.”  If you make certain typos consistently, you can enter your own corrections to the AutoCorrect list, and they will change as well. (  (Again, be careful that it isn’t changing legitimate words or acronyms to other words.)

	Track Changes
	This option allows you to track the changes that are made to your document.  You can turn this on and then have a team member make changes.  When you get it back, you can review the changes and accept or decline them.  Be sure to explore this feature completely before you have someone else alter your paper though, so that you know what the changes will look like, how to accept changes, and how to turn the track changes feature on and off.

	Merge Documents
	This option allows you to combine two versions of the same document and choose which version of each part to accept.  This would work if you have multiple files of the same document that different team members have worked on.  However, again, be sure to experiment with it first before committing your team to combining a paper in this way.

	Protect Document
	This option allows you to password protect your document so that no one else can turn off the form, the tracking options, or the comments that you use (whichever one you choose).

	Online Collaboration
	This allows you to set up an online meeting to collaborate about your document using Microsoft NetMeeting or a similar program.

	Mail Merge
	This allows you to create form letters or mailing labels quickly.  You just include all of the information that will be different, and then the program will go through and allow you to print them all separately.  Be sure to test it out before you waste all of your Christmas stationery though. (

	Envelopes and Labels
	This allows you to set up and print envelopes and labels.

	Letter Wizard
	This allows you to compose a letter in one of many pre-prepared formats.  You got through and type in the information, and the Wizard will format it and place it where it needs to go.

	Macro
	This allows you to record or run macros.  A macro is a recording of keystrokes or other actions.  You could record yourself typing a certain sentence that you have to type frequently, assign the macro to your toolbar, and then every time you clicked that button, that sentence would appear.  Of course, if you spell something wrong while typing the macro, it will be spelled wrong every time you use it, so you have to be careful. (  (Be sure to save your document before you play with macros.)

	Templates and Add-Ins
	This allows you to assign a new template to your document or add an additional one.  You can move styles from one document to another using the organizer.

	Customize
	This option allows you to add new toolbars or customize the ones that you already have.  You can add buttons to your toolbar for options that you use frequently, or take ones off that you never use.  For more information see How do I add a button to my toolbar? on page 19.

	Options
	This allows you to change a lot of things about the way that you interact with Word.  For instance, if you save all of your documents to a folder besides “My Documents” and you want to make that folder your default, you can do this on the File Locations tab.  If you want to set a password so that no on else can open your document, you can do this on the Save tab (of course, the Writing Lab won’t be able to open it either…).  If you want to make sure Word is checking your spelling as you type, you can turn that on (and off) on the Spelling & Grammar tab.  On the General tab, you can increase or decrease the number of documents that you will see on the bottom of the File menu (Recently used file list).  Explore your options. (


The Table Menu
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	Menu Option
	Description

	Draw Table
	This allows you to actually draw the lines of a table with your mouse.  The associated toolbar will have an eraser as well, in case you make a mistake. (

	Insert
	This option allows you to insert a table into your document, or add rows and columns to an existing table.

	Delete
	This option allows you to delete a table from your document, or remove rows and columns from an existing table.

	Select
	This allows you to select parts of a table.  You would use this if you wanted to change the formatting of an entire column, row, or table, rather than only changing the formatting of the cell where your cursor is.

	Merge Cells
	This allows you to join two or more cells together.

	Split Cells
	This allows you to split one cell into two or more.

	Split Table
	This allows you to split one table into two separate tables.

	Table AutoFormat
	This will format your table according to the style that you choose.

	AutoFit
	If your text isn’t fitting into your cell, you can choose AutoFit to contents, and the cell will expand to fit the text.  You can also make all of the columns or rows the same size using the distribute options.

	Heading Rows Repeat
	This allows you to select heading rows that will repeat if your table breaks across a page.

	Convert
	This allows you to convert your table to text, or text to a table.

	Sort
	This allows you to sort your rows… you could alphabetize them, or sort by the second row rather than the first.

	Formula
	This allows you to insert a formula into your table… so that you can add up certain rows or something.  Excel aficionados will like this feature. (

	Show Gridlines
	This allows you to show or hide the gridlines.  Yee-hah.

	Table Properties
	This allows you to change a lot of things about your table such as height, width, horizontal and vertical alignment, borders, shading, margins, etc.  Have fun. (


Specific Questions

How do I insert a header into my document?

To insert a header, select View | Header and Footer from the main toolbar.  You can then right justify the line and type in your abbreviated title (APA) or last name (MLA).  To insert an automatic page number, choose the Insert Page Number button on the Header and Footer toolbar.

How do I change the margins?

To change your margins, select File | Page Setup from the main toolbar.

How do I insert a page break?

You can insert a page break by pressing CTRL + ENTER or by selecting Insert | Break from the main toolbar and then selecting Page Break.

How do I double-space my paper?

To double-space a paper, select Format | Paragraph from the main toolbar, and then under Line Spacing, select Double.

How do I keep a title or heading with the text that follows it?

If your heading is shifting to a page separate from the paragraph that follows it, place your cursor within your heading and select Format | Paragraph from the main toolbar.  On the Line and Page Breaks tab, select Keep with Next.

How do I set up a hanging indent?
(on the APA References page or MLA Works Cited page)

To set a hanging indent either click and drag the bottom margin on the ruler bar, or select Format | Paragraph from the main toolbar.  Under Special there is an option for a hanging indent.

How do I add a button to my toolbar?

Good question, and one that can simplify many tasks.  To customize your toolbar, select Tools | Customize from the Main Toolbar.  Choose the Commands tab, and then select the appropriate category to find the desired button.  Here is a list of some of the most requested:

	Category
	Button
	Description

	Edit
	Replace
	Allows you to find and replace one bit of text with another.  For instance, if you spelled someone’s name “Charla” throughout your paper and then found out it was really supposed to be “Sharla” you could enter these values, and the replace tool would change them all for you.

	View
	Ruler
	Turns the ruler on and off.

	
	Header and Footer
	Allows you to enter information into the Header and Footer areas.

	
	Fit to Window
	Stretches your paper to fit the viewing area.  Depending on your computer’s screen settings, this sometimes makes things easier to see.

	
	Normal
	Switches to the Normal view.

	
	Print Layout
	Switches to the Print Layout view.

	Insert
	Page Break
	Adds a page break to your paper at the point where your cursor is.

	
	Page Number
	Inserts a page number into your document (useful in the header).

	
	Symbol
	Adds symbols not available on your keyboard.  Some useful examples are the em dash (—), the copyright mark (©), all of the accented letters you could ever want (Useful if your name is “Renée”), and several fractions (⅞).

	Format
	Align Left
	Left justifies the text of whichever paragraph your cursor is in.

	
	Center
	Centers the text of whichever paragraph your cursor is in.

	
	Align Right
	Right justifies the text of whichever paragraph your cursor is in.

	
	Double Spacing
	Double-spaces whichever paragraph your cursor is in.


To add one of these buttons to your toolbar, first find it in the list, and then click and drag it up to the toolbar.
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